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Chapter 5

Reconstitution of TCR Signaling Using Supported Lipid 
Bilayers

Xiaolei Su, Jonathon A. Ditlev, Michael K. Rosen, and Ronald D. Vale

Abstract

Biochemical reconstitution has served as an important tool for understanding the mechanisms of many 
cellular processes including DNA replication, transcription, translation, vesicle trafficking, and ubiquitin-
mediated proteolysis. Here, we demonstrate that biochemical reconstitution can be applied to studying a 
complex signaling pathway involving as many as 12 proteins or protein complexes acting at the surface of 
model membranes. We show that a temporal sequence of events in activated T cells beginning with phos-
phorylation of the T cell receptor and culminating in the activation of actin polymerization can be repli-
cated in vitro. Our reconstitution demonstrates the sufficiency of these proteins in producing many of the 
complex behaviors observed during T cell activation. The ability to manipulate all of the components, 
measure reaction rates, and observe molecular behaviors, including at single molecule resolution, has 
enabled us to gain insight into some of the important biochemical features of this signaling pathway such 
as microcluster formation. The same system could be adapted to study other membrane-proximal signaling 
pathways, including growth factor receptors, death receptors, and Eph receptors.

Key words TCR, Microcluster, Reconstitution, Supported lipid bilayer, Multivalency, Phase sep-
aration, Actin, LAT

1  Introduction

T cell receptor (TCR) signaling mediates T cell activation during 
adaptive immune responses. A prominent feature of this signaling 
pathway is that multiple signaling components form submicron- to 
micron-sized clusters on the plasma membrane, though the mech-
anisms and functional consequences of forming these clusters 
remained poorly understood. It had been suspected that microclu-
sters are hot spots for signaling because they are enriched in phos-
phorylated proteins, though direct evidence had been lacking [1, 
2]. To understand the mechanisms of T cell microcluster forma-
tion, we developed methods for reconstituting microclusters using 
purified proteins assembled on supported lipid bilayers in vitro. We 
initially focused on LAT (Linker for activation of T cells) [3], a 
transmembrane adaptor protein that connects upstream TCR 
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activation to multiple downstream signaling pathways including 
calcium mobilization, Ras activation, and actin polymerization 
[4, 5]. We recombinantly expressed a C-terminal fragment of LAT 
containing the four tyrosine residues that have been shown to be 
sufficient for mediating TCR signaling [6–8], phosphorylated the 
purified protein using the syk family kinase ZAP70, labeled it with 
maleimide-conjugated Alexa488, and attached it to planar lipid 
bilayers through the interaction of an N-terminal His8 tag on LAT 
with Ni-NTA-functionalized lipids incorporated into the bilayer. 
pLAT-Alexa488 alone was uniformly distributed on membranes. 
However, when Grb2 and Sos1, two prominent, multivalent bind-
ing partners of LAT, were added, submicron-sized clusters formed 
and gradually grew in size and intensity (Fig. 1). Physical analyses 

Fig. 1 Reconstitution of LAT microclusters on supported lipid bilayers. Top: Schematic of the clustering assay. 
Phosphorylated LAT (pLAT) was attached to Ni-NTA functionalized synthetic supported lipid bilayers through an 
N-terminal His8 tag. The SH2 and SH3 domains of Grb2 bind the phospho-tyrosines in LAT and proline-rich 
motifs (yellow pointy brackets) of Sos1, respectively, thereby creating a network of multivalent interactions. 
Bottom: Total internal reflection fluorescence (TIRF) microscopy imaging of LAT clustering. Clusters were 
formed after Grb2 (0.5 μM) and Sos1 (0.25 μM) were added to membrane-bound pLAT-Alexa488 (300 mole-
cules/μm2) at 0 min. Scale bar: 5 μm

Xiaolei Su et al.
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of these clusters indicated that they formed through a process of 
multivalent assembly and phase separation [9, 10].

Next we extended this reconstitution to a multi-step TCR sig-
naling pathway. The first step in this pathway is phosphorylation of 
the TCR (CD3ζ subunit) by the src family kinase, Lck. 
Phosphorylated TCR recruits the kinase ZAP70 from solution and 
activates it on the membrane. ZAP70, in turn, phosphorylates 
LAT on the membrane [11, 12]. Phosphorylated LAT then recruits 
Grb2, SOS and the additional multivalent adaptor proteins Gads 
and SLP-76, which further recruit the actin regulators Nck, 
N-WASp, and the Arp2/3 complex to promote actin polymeriza-
tion on the membrane [13, 14]. We fluorescently labeled ZAP70, 
LAT, and actin to serve as reporters for TCR phosphorylation, 
LAT clustering, and actin polymerization, respectively. We prein-
cubated all the components in the experimental system. After add-
ing ATP to the reaction to initiate CD3ζ phosphorylation by Lck, 
we observed a rapid recruitment of ZAP70 to the membrane, 
reflecting its binding to phosphorylated CD3ζ. This translocation 
of ZAP70 was then followed by the formation of LAT clusters. 
Actin then co-localized with the LAT clusters on the membrane 
and eventually polymerized and formed bundles (Fig. 2).

These data demonstrate that a multi-step signaling pathway 
can be reconstituted on supported lipid bilayers. The high spatial 
and temporal resolution of the tracking of this reconstituted sys-
tem allows us to understand some critical aspects of the signal 
transduction process, including microcluster formation, exclusion 
of tyrosine phosphatases, and organization of actin regulators [15]. 
Moreover, the reconstitution itself demonstrates the sufficiency of 
the components to produce many of the complex behaviors 
observed in vivo during T cell activation.

2  Materials

	 1.	Proteins: LAT, Grb2, Sos1, Gads, SLP-76, Nck, N-WASp, 
Arp2/3 complex, and actin (see ref. 15 for detailed protocols 
for producing these proteins).

	 2.	Lipid components: 1-palmitoyl-2-oleoyl-sn-glycero-3-
phosphocholine (POPC) (for example (e.g.), Avanti, 850457C), 
1,2-dioleoyl-sn-glycero-3-[(N-(5-amino-1-carboxypentyl)imi-
nodiacetic acid)succinyl] (DOGS-NTA) (e.g., Avanti, 
790404C), 1,2-dioleoyl-sn-glycero-3-phosphoethanolamine-
N-[methoxy(polyethylene glycol)-5000] (PEG-5000 PE) (e.g., 
Avanti, 880230C) (see Note 1).

	 3.	Selected 96-well glass bottom plate (flat glass, upper plastic 
structure with low fluorescence background and resistant to 
detergent, acid, and base treatment, e.g., Matriplate 
MGB096-1-2-LG-L).

Reconstitution of TCR Signaling Using Supported Lipid Bilayers
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Fig. 2 Reconstituting a TCR-LAT-actin pathway. Top: Schematic of the components involved in a reaction 
designed to reconstitute a signaling pathway from CD3ζ/TCR phosphorylation to actin polymerization. ZAP70-
505-Star, LAT-Alexa647, and actin-Rhodamine serve as reporters for TCR phosphorylation, LAT clustering, and 
actin assembly, respectively. Lck, CD3ζ, and LAT were attached to the membrane and incubated with other 
components in solution. Bottom: TIRF microscopy revealed ZAP70 membrane recruitment, LAT clustering, and 
actin polymerization in the reconstituted assay after the addition of ATP at time 0. Input: 2.5 nM His-tagged 
Lck, 5 nM His-tagged CD3ζ, 10 nM His-tagged pLAT-Alexa647, 10 nM ZAP70-505-Star, 250 nM Gads, 500 nM 
SLP-76, 1000 nM Nck, 500 nM N-WASp, 5 nM Arp2/3 complex, 1000 nM actin (5% Rhodamine labeled), and 
0.5 mM ATP-Mg. Scale bar: 5 μm

Xiaolei Su et al.
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	 4.	Adhesive PCR Sealing Foil Sheets (e.g., Thermo Fisher 
AB-0626).

	 5.	Glass vials (e.g., National Scientific B7800-2).
	 6.	Hellmanex III (e.g., Sigma Z805939).
	 7.	Gastight Syringes 25 μL (e.g., Hamilton 80,275), 250 μL 

(e.g., Hamilton 81,175).
	 8.	Argon.
	 9.	Chloroform (e.g., Electron Microscopy Sciences 12,550).
	10.	PBS buffer: 155 mM NaCl, 3.0 mM Na2HPO4, 1.1 mM 

KH2PO4, pH 7.4.
	11.	NaOH.
	12.	Basic buffer: 50 mM HEPES-Na+, 150 mM NaCl, and 1 mM 

Tris(2-carboxyethyl)phosphine (TCEP), pH 7.4.
	13.	Clustering buffer: 50 mM HEPES-Na+, 150 mM NaCl, 1 mM 

TCEP, and 1 mg/mL BSA (heat shock fraction, ≥98%), pH 7.4.
	14.	Signaling buffer: 35 mM HEPES, 60 mM NaCl, 30 mM KCl, 

0.4 mM TCEP, 1 mM MgCl2, and 0.4 mg/mL BSA, pH 7.2.
	15.	High speed centrifuge and polycarbonate centrifuge tubes.
	16.	Heat Block.
	17.	Glucose.
	18.	β-mercaptoethanol.
	19.	Glucose oxidase.
	20.	Catalase.

3  Methods

	 1.	Clean the glass vial with 5% Hellmanex III, rinse thoroughly 
with ultrapure water (18.2 MΩ at 24 °C).

	 2.	Warm up individual lipid stocks to room temperature  
(see Note 2).

	 3.	Use glass syringes to prepare a DOGS-NTA lipid mix in the 
glass vial as follows: rinse the vial with chloroform, add ~1 mL 
of chloroform, and then individual lipids (see Note 3). The 
total lipids add up to 4 μmol.

Lipid composition:
98% POPC
2% DOGS-NTA (see Note 4)
0.1% PEG-5000 PE

	 4.	Dry the lipid mix with a stable flow of argon. Use an ~45 °C 
water bath during drying (see Note 5). You will see multiple 
white layers adhered to the wall of the vial after the lipids 
are dried.

3.1  Preparation 
of Small Unilamellar 
Vesicles (SUV)

Reconstitution of TCR Signaling Using Supported Lipid Bilayers
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	 5.	Continue to dry the lipids completely in a desiccator over 2 h.
	 6.	Resuspend the dried lipids in 1.5 mL of PBS and vortex.
	 7.	Transfer the resuspension into two 1.5 mL conical microcen-

trifuge tubes (750 μL each).
	 8.	Freeze the resuspension in liquid nitrogen and thaw in a water 

bath at room temperature. Repeat the freeze-thaw for 30 
cycles. The cloudy solution will become clear over the freeze-
thaw cycles (see Note 6). The cleared resuspension can be 
stored at −80 °C for future use.

	 9.	Centrifuge the resuspension at 33,500 × g for 45 min at 4 °C.
	10.	Transfer the SUV-containing supernatant to a clean tube. 

Avoid disturbing the white pellet at the bottom of the tube 
during the transfer. In the new tube, cover the SUV solution 
with argon atmosphere. Store it at 4 °C. Use the SUV within 
2 weeks (see Note 7).

It is absolutely essential that clean glass is used when making sup-
ported lipid bilayers. Glass that is not extremely clean will cause 
defects in the bilayers and will impair lipid mobility and reproduc-
ibility of experiments. Here, we introduce the use of Hellmanex 
III and NaOH to clean the glass.

	 1.	Immerse a 96-well imaging plate into 1 L of 5% Hellmanex III 
in a 1 L beaker. Microwave to 50 °C. Stir and incubate over-
night at room temperature. The next morning, rinse each well 
with ultrapure water ten times. Blow-dry each well. Seal the 
plate with adhesive foil.

	 2.	Use a blade to open the wells that will be used. Add 250 μL of 
freshly made 5 M NaOH to each well, incubate at 50 °C for 1 
h on a heat block. Remove NaOH, repeat the cleaning twice 
(see Note 8).

	 3.	Rinse each well with 500 μL of ultrapure water twice, and then 
500 μL of basic buffer twice.

	 4.	Add 200 μL of basic buffer to each well, and then 5 μL of SUV 
solution. Tap the tube containing the SUV solution gently to 
mix before transferring to the wells. Incubate the plate at 37 
°C for 1–1.5 h to allow the bilayer to form. From here on, 
make sure the bilayers are always covered with buffer (a mini-
mum volume of ~50 μL in the well).

	 5.	Wash each well with 500 μL of basic buffer three times.
	 6.	Block the bilayers with clustering buffer and incubate for 

20 min at 37 °C.

3.2  Preparation 
of Supported Lipid 
Bilayers

Xiaolei Su et al.
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	 1.	Dilute His8-tagged, pre-phosphorylated, and Alexa488 (or 
other dye)-labeled LAT in clustering buffer and add the mix to 
the well and incubate for 2 h at 30 °C (see Note 9).

	 2.	Wash each well with 500 μL of clustering buffer three times.
	 3.	Prepare an oxygen scavenger solution by mixing 0.2 mg/mL 

glucose oxidase, 0.035 mg/mL catalase, 25 mM glucose, and 
70 mM β-mercaptoethanol in clustering buffer. Add the solu-
tion to the well. The total solution volume in well is 90 μL.

	 4.	Start a time-lapse movie using TIRF (Total Internal Reflection 
Fluorescence) microscopy. At the beginning, LAT will appear 
evenly distributed on the supported lipid bilayer (see Note 10).

	 5.	Add 0.5 μM Grb2 and 0.25 μM Sos1 in 10 μL of clustering 
buffer during the time-lapse acquisition. Pipette up and down 
gently several times to mix well. Avoid touching the bilayer 
with the pipette tips. Monitor the cluster formation process 
(Fig. 1).

	 1.	Add His10-tagged Lck, CD3ζ, and fluorescently labeled His8-
LAT in clustering buffer to the well and incubate for 3 h at 30 
°C on a heat block or in an incubator.

	 2.	Wash each well with 500 μL of clustering buffer two times, 
followed by 500 μL of signaling buffer once.

	 3.	Prepare an oxygen scavenger mix by including 0.2 mg/mL 
glucose oxidase, 0.035 mg/mL catalase, 25 mM glucose, and 
70 mM β-mercaptoethanol in signaling buffer. Add Alexa505-
ZAP70, Gads, SLP-76, Nck, N-WASp, Arp2/3 complex, and 
Rhodamine-actin at desired concentrations to the scavenger 
mix (see Fig. 2 legend for recommended concentrations). Then 
add the entire mix to the well. The total solution volume in 
well is 90 μL.

	 4.	Start a time-lapse movie using TIRF microscopy.
	 5.	Add 0.5 mM ATP-Mg in 10 μL of signaling buffer to the reac-

tion mix during the time-lapse acquisition. Pipette up and 
down gently several times to mix well. Avoid touching the 
bilayer with the pipette tips. Monitor the sequential signaling 
steps from TCR activation, to LAT clustering, finally resulting 
in actin polymerization (Fig. 2).

	 1.	Prior to image analysis, capture five images of an empty well 
(see Note 11). These will be used to determine the noise of the 
camera without fluorescence.

	 2.	Also capture five images of an SLB coated with His8 pLAT-
Alexa488 (see Note 12) using microscope settings identical to 
those used for time-lapse acquisition. These will be used to 
create a flat-field image.

3.3  Imaging LAT 
Microcluster 
Formation

3.4  Imaging 
a Signaling Pathway 
from TCR to Actin

3.5  Analyzing 
Cluster Formation 
with FIJI (ImageJ)

Reconstitution of TCR Signaling Using Supported Lipid Bilayers
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	 3.	Prior to image analysis, set up the proper measurements in 
FIJI. The three essential measurements are the integrated fluo-
rescent intensity of the image (the sum of all pixel intensities 
within the opened image), maximum intensity, and the stan-
dard deviation of the pixel intensities. To set these go to the 
Set Measurements menu (found in the Analysis menu) and 
select “Standard deviation,” “Min & Max gray value,” and 
“Integrated density.”

	 4.	To determine the camera noise, open the images from step 1 
using FIJI, create a stack using the “Images to Stacks” func-
tion (found in the Image menu under Stacks), Z-project the 
stack (also found in the Image menu under Stacks) using the 
“Average Intensity” projection type, and measure (Ctrl-M or 
found in the Analyze menu) the averaged image to determine 
the average pixel intensity. This value will be subtracted from 
each image used for flat-field correction as well as each frame 
of the time-lapse.

	 5.	To flat-field correct the time-lapse, we first create a “ratio 
image” that is used to flatten the intensity within each frame of 
the time-lapse (see Note 13). Open the five images of His8 
pLAT-Alexa488-coated SLBs from step 2 using FIJI, subtract 
the noise value determined in step 3 from each image using 
the Subtract command (found in the Process menu under 
Math), create a stack using the “Images to Stacks” function 
(found in the Image menu under Stacks), Z-project the stack 
(also found in the Image menu under Stacks) using the 
“Average Intensity” projection type, and determine the maxi-
mum pixel intensity in the averaged image using the measure 
command (Ctrl-M or found in the Analyze menu). Divide the 
averaged image by the maximum measured intensity (the 
Divide command is found in the Process menu under Math) to 
obtain the “ratio” image. Keep the “ratio” image open and 
open the time-lapse that will be analyzed. Open the Calculator 
Plus (found in the Process menu) and select the “Divide” 
operation using the time-lapse as i1, the “ratio” image as i2, 
leaving k1 as 1.0, and k2 as 0.0. Upon completion of this pro-
cess, the time-lapse will now be flat-field corrected.

	 6.	We have used two approaches to analyze cluster formation in 
our assays. In the first approach, we measure the variance of 
clustering in the frame of interest from a time-lapse of cluster 
formation (see Note 14). The variance of the image is simply 
the standard deviation in pixel intensities from the image 
squared (Variance = Standard Deviation2). To measure vari-
ance in FIJI, open the time-lapse to the desired frame, measure 
the standard deviation (Ctrl-M or found in the Analysis menu 
using the Measure command), and square the standard devia-
tion. We use variance measurements to determine whether 

Xiaolei Su et al.
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clusters have formed under different sets of experimental con-
ditions. If the variance of an image containing clustering agents 
is significantly different than the variance of an image of a 
bilayer coated with an unclustered His8 pLAT-Alexa488 (t-tests 
or ANOVA can be used depending on the number of condi-
tions being compared), we consider the critical concentration 
for phase separation has been reached. This is important for 
determining whether the conditions being used result in clus-
ter formation that can lead to downstream signaling.

	 7.	In the second approach, we measure the fractional intensity of 
fluorescent molecules found in clusters (see Note 14). This 
requires two independent measurements. First, measure the 
total intensity of the image with the measure command (Ctrl-M 
or found in the Analysis menu) and record the integrated den-
sity of the image. Next, use the triangle algorithm to set a 
threshold for the image (Ctrl-shift-T or found in the Adjust 
tab in the Image menu) (see Note 15) and measure the total 
intensity of the thresholded region (to measure the integrated 
density within only the thresholded region, go the to Set 
Measurements menu in the Analysis menu and select “limit to 
threshold”). Divide the thresholded integrated density by the 
total integrated density to obtain the fractional intensity. We 
use fractional intensity as a metric for how many molecules are 
located within clusters versus outside clusters. This measure-
ment provides a metric for comparing the level of clustering 
between different experimental conditions (see refs. 9, 10, 15) 
as examples of how clustering can be compared between differ-
ent experiments).

4  Notes

	 1.	New users of lipids should read FAQ and tips for storage and 
handling of lipids from Avanti Polar Lipids, Inc.

http://avantilipids.com/tech-support/faqs/
http://avantilipids.com/tech-support/storage-handling- 

of-lipids/
	 2.	Once a lipid vial is opened, store the remaining unused lipids 

in a clean capped glass vial. Fill the space above lipids with 
argon to prevent potential oxidation of lipids. Store the vial at 
−20 °C. Alternatively, for a modest price one can request bot-
tling service from Avanti Polar lipids, which provides small ali-
quots of lipids of a specific volume (chosen based on your 
experimental needs).

	 3.	When transferring small amount of lipids, rinse syringe with 
the lipids first to avoid any dilution of lipids.

Reconstitution of TCR Signaling Using Supported Lipid Bilayers
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	 4.	We have found that supported lipid bilayers containing 2% 
DOGS-NTA lipids provide more stable and reproducible 
attachment of His-tagged proteins than bilayers containing 1% 
DOGS-NTA. We have also found that bilayers containing 5% 
DOGS-NTA or more tend to become less fluid (longer recov-
ery time when tested by FRAP).

	 5.	Adjust the argon flow to allow only small ripples during the 
drying process. Usually, it takes ~5 min to dry 2 mL of lipids 
in chloroform. It is highly recommended to immerse the lower 
half of the vial in a warm water bath (~40 °C) because evapora-
tion of chloroform will take heat away and cool the bottle 
down, which could potentially reduce the solubility of lipids or 
cause phase separation.

	 6.	Using bath sonication can greatly reduce the cycle numbers.
	 7.	The duration that SUVs can be stored at 4 °C depends on the 

stability of the specific lipids used in an experiment. It is worth-
while testing the quality of bilayers by FRAP (fluorescence 
recovery after photobleaching) to determine the maximal stor-
age time for a specific lipid mixture.

	 8.	Keep the temperature of the heat block below 50 
°C. Overheating will cause the glue of the plate to melt and 
solutions will leak into neighboring wells.

	 9.	In our experience, an input of 3 nM phosphorylated LAT with 
an incubation of 2 h will result in a membrane density around 
300 molecules/μm2. The final membrane density scales 
roughly linearly with the input concentration in a range of 
0.1–10 nM. For any new proteins, we recommend measuring 
the membrane density [15] at the range needed for the assay.

	10.	When using a new membrane-bound protein, it will be neces-
sary to determine the mobility of that protein by FRAP to 
ensure that the protein behaves well on the membrane. 
Sometimes, black holes appear on the bilayer when imaging 
fluorescently labeled protein, indicating membrane defects. 
Membrane defects are usually caused by insufficient cleaning of 
the glass.

	11.	It is important to know (and subtract) the baseline noise for 
the camera used to capture time-lapse images of cluster forma-
tion when quantifying fluorescent intensities within the time-
lapse. The easiest way to determine the noise of the camera is 
to capture images in an empty well.

	12.	There are multiple methods for creating a flat-field image. 
Alternative methods can be found at http://imagej.net/
Image_Intensity_Processing.

	13.	TIRF microscopy often results in an uneven illumination field. 
To accurately quantify clustering, we need to “flatten” the 

Xiaolei Su et al.
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uneven field so that the intensity of both clustered and non-
clustered regions of the image can be accurately measured.

	14.	We use both variance and fractional intensity to compare the 
degree of clustering in any given set of experimental conditions 
(see refs. 9, 10, 15 as examples of how clustering can be com-
pared between different experiments). Variance is a good mea-
sure of how clustering changes the distribution of molecules, 
from a uniform density to small, intense regions upon the clus-
tering of molecules. Larger, more intense clusters within 
images will result in an increased variance. Likewise, an 
increased number of clusters within an image will also result in 
an increased variance. Fractional intensity is a good measure of 
the percentage of molecules that are clustered within any given 
image. As the number of clusters within an image or the size 
and intensity of clusters within an image increases, the frac-
tional intensity of clusters will also increase.

	15.	The triangle thresholding algorithm yielded similar results to 
an iterative manual procedure that was used to identify pixels 
with intensities greater than three standard deviations above 
the mean of regions outside of clusters [10].
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